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1  Introduction 

We are pleased to welcome you as a Springer-Verlag author. You will have already dis-
cussed the parameters concerning content, length and submission date with your Springer 
contact and agreed to prepare your manuscript ready for printing. This means that you will 
also prepare the final page layout (author-formatted book). (Separate instructions for 
manuscripts without page layout are available.) You will submit PDF files suitable for print-
ing (offset print), which have been prepared using Acrobat Distiller, with all figures embed-
ded. We provide a job-options-file with the required settings for the Distiller (see Sect. 14 
Manuscript Submission).  

Please note: If you do not have access to Acrobat Distiller, please contact us before you 
start preparing your manuscript. The program PDF Writer is unsuitable for creating PDF 
printing files. It is also not possible to print from Word Files. 

In exceptional cases, the printout can be used as a print master, i.e. reproduced directly 
from the paper version (camera ready). This is only possible if the manuscript does not con-
tain any photos or grey scale figures. Furthermore, the paper version must then be submitted 
with the final layout, printed using a 600-dpi-laser printer. 

1.1  Preparation 
We recommend that the text, tables and figures are prepared initially. Start working on the 
layout only after the final text version has been proofread or, as agreed, checked by one of 
our copy editors, and when all figures are in their final format (see Sect. 7 Figures).  

Word template. For authors working with Word 7, 97, 2000, XP or Word for Macintosh, a 
Word template (sv-layout-mono-e.dot for monographs and sv-layout-contr-e.dot for contrib-
uted/ multi-authors books) is provided. All the necessary formats are preset in the templates. 
This means that keystrokes can be used to insert the formats in your manuscript.  

The templates can be downloaded from our Web site springeronline.com, for authors, in 
your particular discipline. They are packed in a ZIP archive together with the instructions for 
downloading and using the template and the job options file. Download the ZIP file onto 
your PC, unzip it and follow the instructions for using the template. (When using the job op-
tions please refer to Sect. 14 Manuscript Submission). 

Printer properties. Before you start writing your text, select either a PostScript printer or 
Acrobat Distiller as your standard printer (you can check under File > Print ... Printer; under 
"Type", select a "PS" printer). Please inform your Springer contact if you do not have a PS 
printer. Remember to deactivate the option "Use printer metrics to layout document" under 
the menu options Tools > Options > Compatibility1. Try to avoid making any changes to 
your PC or printer driver when preparing the layout. Following these instructions will ensure 
that the layout displayed on screen is identical to the desired final book layout. 

Data storage. Prepare your manuscript chapter-wise, saving each individual chapter in a 
separate file, named with the chapter number (01.doc, 02.doc, etc.). Save these files in a di-
rectory on your PC, such as E:\\manuscript\\Springerbook\\01.doc (do not use directory or 
file names containing blanks, e.g. "My documents", see Sect. 12 Contents).  

Sample file. Please send us a representative sample chapter (PDF with embedded figures) 
together with the printout, before completing the entire manuscript. This will allow us to 
check the layout as well as the technical data requirements in advance. Such a sample chap-
ter should be prepared using the Springer job options (see Sect. 14 Manuscript Submission).  

                                                      
1 The names for Word functions as well as the organisation of the menu can vary from one Word version to  

another. 
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1.2  Tips and Hints 
Further information on the preparation of manuscripts or the use of the templates can be 
found on our Web site. We would be pleased to give you further links where you can find 
suitable sample pages.  

2  Page Layout  

Your book will be printed in the 15.5 × 23.5 cm format (width × height of book pages). The 
printed area of a page (called the type or print area) is 11.7×18.8 cm. The header (running 
head) appears above the print area.  

The Change Margins function in our document template can be used to automatically in-
stall the print area. If you do not use Springer's Word template, or if you intend to use a pa-
per size other than A4, e.g. US letter format, the print area will need to be set up manually. If 
a different book format has been agreed upon, we will be pleased to accommodate these 
measurements.  

Always use the entire height and width of the print area. In exceptional cases, the print a-
rea may be shortened by one line to avoid having the first line of a new paragraph at the end 
of a page or the last line of a paragraph at the beginning of the next page. To do this, enter a 
manual page break (Insert > Break; select the break type "Page break"). 

The print area must also be reduced if there is only space for one line after a heading; in 
this case, the paragraph should appear on the next page along with the heading.  

3  Fonts  

Please use Times or Times New Roman fonts for plain text, and Helvetica or Arial fonts for 
titles and headings.  

To ensure that the TrueType fonts you have used are also embedded in the PDF file, 
choose the save option "Embed TrueType fonts" (menu Tools > Options > save). 

In order to distinguish the literal text of computer programs from running text, we recom-
mend using a font such as Arial or Helvetica. If you need a font for your programs where e-
very character has the same width, use Courier. 

Special characters. If possible, use the fonts Symbol (and/or Wingdings) (not ZapfDingbats) 
for special characters or icons. Occasionally, some characters are replaced by other fonts 
when creating PDF files, therefore check your PDF printout carefully, especially the figures, 
to ensure that all the characters have been printed correctly.  

Font sizes. The fonts are preset in Springer's document template. The fonts, font sizes and 
formats used are summarized in Table 1.  

Table 1. Font sizes and spacing 

Text element Font size Spacing, indentation  
Title  Helvetica 14 pt, 

bold 
spacing after: 84 pt 

H1  Helvetica 12 pt, 
bold 

spacing before: 26 pt, spacing after: 14 pt 

H2  Helvetica 10 pt, 
bold 

spacing before: 22 pt, spacing after: 11 pt 

H3  Helvetica 10 pt, 
bold, italics 

spacing before: 16 pt, spacing after: 8 pt 

Text  Times 11 pt single line spacing, indent 0.4 cm 
Displayed lists  Times 11 pt  single line spacing, hanging indent 0.4 cm 
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Spacing   6 pt 
Petit  Times 10 pt  single line spacing, indent 0.4 cm 
Important!  Times 10 pt  single line spacing, indent 0.5 cm left and right,  

spacing before and after: 6 pt,  
frame with 2 pt spacing 

References  Times 10 pt  single line spacing, hanging indent 0.6 cm 
Footnote  Times 10 pt  single line spacing, hanging indent 0.3 cm 
Table caption  Times 10 pt  single line spacing, spacing before: 12 pt,  

spacing after 6 pt 
Table, table notes  Times 10 pt  single line spacing, flush left 
Figure legend  Times 10 pt  single line spacing, spacing before: 6 pt,  

spacing after: 12 pt 
Headers  Times 10 pt line spacing 11 pt, spacing after: 6 pt,  

line below with 0.5 pt spacing 
Contents Times 11 pt  
Index Times 10 pt  

4  Titles and Headings  

A well structured text and meaningful headings make it easier for the reader to gain a general 
overview of the text. Please use the decimal system of headings with no more than three lev-
els. 

1 Chapter title (Title) (appears at the top of a new page) 
1.1 First level heading (H1) 
1.1.1 Second level heading (H2) 
 Third level heading (H3) (without number) 

If an additional heading level is required, place it at the beginning of the relevant para-
graph ("run-in-heading"), which should not be indented. Additionally, click the "Line Space" 
button and format the run-in heading in bold.  

The heading font size and the spacing required before and after headings is given in Sect. 
3 Fonts. The correct fonts and font sizes are preset in the document template. 

Note: If two headings of different categories appear one after the other in the text, the spa-
cing between them has to be reduced. To do this, select the second heading and choose For-
mat > Paragraph. Set "Spacing Before" to 0.  

Please insert a blank space, without a period, after the heading numbers and align all head-
ings flush left. Try to limit the heading text to one line; otherwise problems will arise when 
the headers are inserted automatically (see Sect. 10 Headers and Page Numbers). Use capital 
and lowercase letters for headings. In cross-references, insert the chapter or section number 
(e.g., see Chap. 5; see Sect. 3.5.1).  

Contribution Headers (applies only to multi-authored books).The title of the contribution 
is followed by the name/s of the author/s ("Author" button). Where there are several co-
authors, the names are separated by commas. The address of the institute or place of work is 
entered on the next line ("Address" button ). If different addresses are required for different 
authors, each address must begin on a new line, and superscript numbers used to indicate 
which author is affiliated to which institute etc.  
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5  Text  
5.1  Paragraphs, Emphasis, Small Type, Footnotes 
Paragraphs. The first line of a paragraph is not indented after a heading. In all other text pa-
ragraphs, the first line is indented. Paragraphs are written as fully justified text.  

The template provides two buttons for paragraphs, the standard paragraph (first line in-
dented) as well as the none indented paragraph, which appears automatically after a heading. 
Where the template has not been used, these two paragraph formats should be defined before 
writing commences.  

Emphasis in the text. In standard text, please set emphasized words or phrases either in 
boldface or italic. Note: Too much emphasis may actually confuse readers, therefore it 
should be used economically. 

Small type. The "Petit" button can be used for text passages that should be formatted in a 
smaller font size e.g. for longer examples or quotations.  

Footnotes. In standard text, the footnotes are marked with superscript numbers. The "Foot-
note" button can be used to call up the footnote function; the footnotes are numbered auto-
matically and added to the end of the page. 

5.2  Technical Terms, Abbreviations, Units 
• Ensure that the spelling of names, terms, and abbreviations is consistent, also when in-

cluded in tables, figures and figure legends. 
• Abbreviations, except for very common ones, must either be defined the first time they 

are mentioned or a list of abbreviations should be included in the front matter. 
• Please use the following abbreviations for cross-references: p./pp. (page/s); 

Chap./Chaps. (chapter/s); Sect./Sects. (section/s); Fig./Figs. (figure/s); Eq./Eqs. (equa-
tion/s). However at the start of a sentence, the word must always be written out in full. 
Note: the word "Table" is never be abbreviated. 

• Always use internationally accepted signs and symbols for units, so-called SI units.  
• Chemical compounds are named according to the systematic rules of the IUPAC or 

Chemical Abstracts. 
• Species and genus names, mathematical or physical variables, and prefixes in chemical 

compounds should be formatted in italic (Arabidopsis, cis/trans, d/l, E/Z, o/m/p, R/S, t-
Bu, tert-butyl). Note: et al., in vivo, in situ, etc. are formatted in normal type not italics. 

• L and D indicating optical activity should be formatted in SMALL CAPITALS (D- and L-
dopa). 

5.3  Displayed Lists  
The design of displayed lists should be consistent throughout the book. Do not refer to dis-
played lists as tables. Springer's document template provides three different options for pre-
senting lists: bullets, dashes or numbers.  

Line spacing of 0.2 cm should be inserted before and after a displayed list. To do so, place 
the cursor in the first line of the displayed list and click the "Line Space" button. Then move 
the cursor to the first line of the text following the list and click the "Line Space" button 
again to insert the correct spacing.  
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5.4  Equations  
Equations appear on separate lines and are numbered chapter-wise. The equation number is 
placed in parentheses to the right of the aligned text next to the equation (see Eq. 5.1). 

(a+b) 2 =  a2 + 2ab + b2 (5.1) 

By using the "Equation" button, two table cells are inserted. There is a box on the right for 
the equation number, and one on the left for the equation itself.  

If the equation is part of a sentence, it should end with a punctuation mark (not after the 
equation number).  

Simple equations such as a2 + b2 = c2 can be written as normal text. For all other equa-
tions, use MathType or the Microsoft Equation Editor, and insert the graphic into the text file 
as an object. Prepare the whole equation in this way and not just part of it. Symbols or spe-
cial characters that are not part of an equation should not be prepared as graphics or with the 
equations editor, if they are available in a font (see Sect. 3 Fonts). 

6  Tables  

Tables consist of the following elements: the table caption, the actual table with the table 
head and table footnotes, where applicable. Tables are set in a smaller font size than the rest 
of the text (see Sect. 3 Fonts). Tables should have at least two rows and two columns. Sim-
ple, one-column lists should not be treated as tables, but rather incorporated in the running 
text. 

Springer's document template facilitates creating tables with the following commands:  

Table Title The word "Table" and the table number are inserted automatically; only 
the chapter number and the caption need to be inserted.  

Insert table  Opens a dialog box in which the number of rows and columns can be 
specified.  

Insert Rows  Adds a row above the cursor position.  
Delete Rows Deletes the row in which the cursor is located. 
Insert Columns Adds a column to the left of the cursor position.  
Delete Columns Deletes the column in which the cursor is located. 
Format Table Formats the table according to Springer style. Place the cursor anywhere 

in the table and click the button.  
Table Footnote Place the cursor directly beneath the table, click the button, and write the 

table note . If there is text following the note, insert a blank line.  

Notes to Tables: 

• Tables are structured using horizontal lines above and below the column headings and a 
line beneath the columns. If necessary for didactic reasons, additional lines, both hori-
zontal and vertical, can be inserted.  

• Information in cells is aligned flush left, but numbers are arranged "decimally", i.e. all 
the units, tens, hundreds etc. underneath one another.  

• Metric/physical units in the column headings are placed in square brackets.  
• Notes on abbreviations are inserted below the final row of the table and are aligned flush 

left; abbreviations needing explanation are formatted in italic type.  
• Footnotes in tables are indicated by superscript lowercase letters. The footnotes them-

selves appear beneath the table and begin with a capital letter and end with a period.  
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• The word "Table" is generally not abbreviated. It appears in the table caption with the 
relevant number in bold. Where a table does not fit on a page and has to be continued on 
the next, it is unnecessary to repeat the entire table caption, but rather e.g. "Table 6.1. 
(cont.)". 

• If in exceptional cases, a table is too large and needs to be placed up end, the header 
must nevertheless be placed at the top of the page as well as on all other pages. As this is 
not possible in Word, save your table as a graphic eps-file2, open a graphic program to 
rotate the table by 90° and insert it into the Word text from the menu options Insert > 
Picture > From File. 

Number the tables consecutively and ensure that all the tables in the text are cited in the 
correct order (e.g., Table (1.)1, Table (1.)2, ...). Tables are normally placed near the relevant 
citation in the text and, where possible, should appear either at the top or the bottom of a 
page.  

7  Figures 

When preparing the figures, it is very important that the technical requirements are taken into 
consideration in order to obtain a high quality print output. We recommend that each figure 
is prepared individually. Please fell free to contact Springer if you experience problems in 
following the requirements or have any questions regarding the preparation of electronic fig-
ures. Please send us some figure samples in advance so that we can check and clarify the 
technical details.  

Colour illustrations (drawings or photographs) are expensive in comparison to black and 
white, and thus, can only be accepted if the extra printing costs are met by the author. (Clar-
ify this point with your Springer contact.) 

7.1  Scanning and Resolution 
• Scan all the illustrations in the same size as they should appear in print (print area of 

each page is 11.7 x 18.8 cm). 
• If possible, do not scan printed material as this produces a lower contrast.  
• The minimum resolution for scanned line drawings is 800 dpi, for fine details (small 

lettering) 1200 dpi (in the final size). 
• For scanned photos (grey scale figures), a minimum of 300 dpi is required; for photos 

with lettering 600 dpi is recommended. 
• If the figure has to be enlarged, the resolution is calculated as follows: required final 

resolution (e.g. 300 dpi) x printing width (120 mm) divided by the original figure width 
(e.g. 36 mm); this illustration must be scanned at 1000 dpi.  

• Note: Illustrations directly taken from the Internet produce a low quality print output. 
For figures displayed on screen, a resolution of only 72–96 dpi is sufficient. 

7.2  Image Processing  
• Adobe Photoshop or Corel Photopaint are suitable programs for processing scanned 

photos.  
• Use illustration programs such as Adobe Illustrator, Corel Draw, Macromedia Freehand 

for graphics. 

                                                      
2 To this end, prepare your table in a separate file, mark the table and select under the menu option File > Print 

the page range “Selection”; then klick on “Print to file” and OK. The file will be stored as a printer file (.prn). 
Mark the file in the Windows explorer or on your desk top and change “prn” into “eps”. 
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• Programs such as MS Excel, MS Powerpoint, Designer, Visio, MS Word-Graph, MS 
Graph or Harvard Graphics are only suitable if the figures can be saved as eps files.  

• The lowest line weight is 0.6 pt in the final size (approx. 0.2 mm). Finer lines (hairlines) 
produce broken lines after high resolution typesetting even if the printout looks fine.  

• Where illustrations should appear in black and white, do not produce them in colour. 
This could lead to a loss of quality. 

• Instead of colour, use screened areas with grey shades of 10%, 25%, and 50%. For 
backgrounds use a grey shade of 10-15%; any lettering on such areas must be clearly le-
gible. 

• If possible, all colour figures should be in the same colour modus (CMYK or RGB). 

7.3  Lettering 
• Please do not insert any figure legends or figure captions in your illustration file.  
• Lettering should not be added to photos until after scanning, i.e. to the graphics file. 
• To add lettering to illustrations, a sans serif font such as Arial or Helvetica is recom-

mended. The font size should be approx. 2-3 mm (8-10 pt). 
• Lettering must be uniform in size (in the final figure format) and type.  
• Avoid effects such as shading, outline letters or frames which reduce legibility. 

7.4  Saving and Inserting into the Text File 
• Save each individual illustration in the size that it should be in print.  
• Save figures in a suitable standard format such as EPS (include any fonts used and save 

in the preview modus!), TIFF, JPG, or BMP; ensure they have a sufficiently high resolu-
tion. 

• Note: PDF Files that have been generated from Word files use the RGB colour modus, 
whilst the CMYK modus is required for book printing. Therefore, colours may differ 
slightly from the original after the printer has transformed them into CMYK. Only em-
bedded EPS files retain the CMYK colour. 

• Place the figures near to the citation in the text, at the beginning or the end of a page so 
that the text flow is interrupted as little as possible. 

• Choose the "Insert Graphic" button or select the menu options Insert > Picture > From 
File to insert graphic files. 

• Enter a blank line between the text and figure.  

7.5  Figure Legends 
The figure legend must always appear beneath the figure and contain the caption of the fig-
ure and any necessary explanation. Number the figures consecutively or chapter-wise (e.g., 
Fig. 1.1, Fig. 1.2) and ensure that all the figures in the text are cited in the correct order. The 
"Figure Legend" button inserts "Fig." and the figure number automatically; just add the 
chapter number and the legend. 

The abbreviation "Fig." and the figure number together with any figure parts (a, b, c etc.) 
should appear in bold. In the legend, format the lettering in the figure, which is explained in 
the legend, in italic type. Legends do not end with a period. For the type size, refer to the ta-
ble in Sect. 3 Fonts. Please enter a blank line after the legend.  
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8  References  

Citations in the text. References are cited in the text by author name/s and the year of pub-
lication in parentheses.  

one author: (Miller 2001), ... as described by Miller (2001) 
two authors: (Miller and Smith 1999) 
three authors or more: (Miller et al. 2002) 

Reference list. All publications cited in the text must be included in the reference list, which 
is listed alphabetically by authors. If there are several works by the same author, the follow-
ing order must be used: 

• first, all works by the author alone, ordered chronologically by year of publication, 
• next, all works by the author with a co-author, ordered alphabetically by co-author, 
• finally, all works by the author with several co-authors, ordered chronologically by year 

of publication. 

Examples 

• Journals: 
Gygi SP, Corthals GL, Zhang Y, Aebersold R (2000) Evaluation of two-dimensional gel 
electrophoresis based proteome analysis technology. Proc Natl Acad Sci USA 97:9390-
9395 

• Books: 
Ingegnoli V (2002) Landscape ecology: a widening foundation. Springer, Berlin Heidel-
berg New York  

• Contributions to a book: 
Grant WD, Jones BE (2000) Alkaline environments. In: Lederberg J (ed) Encyclopaedia 
of microbiology, vol 1. Academic Press, San Diego, pp 126-133 

Use the following abbreviations: vol (volume), edn (edition), ed/eds (editor/s), p/pp 
(page/s). Do not put commas between names and initials, and periods after initials or abbre-
viations.  

If there is a joint reference list for all the chapters at the end of the book, the heading 
"References" should appear as a chapter title ("Title" button), but without a number. If each 
chapter has its own reference list at the end of the chapter, the heading "References" should 
appear as a level one heading ("H1" button), also without a number.  

Use the "Reference" button to style the entries in the reference list, or follow the instruc-
tions in Sect. 3 Fonts. 

References with numbers. Alternatively, references may be cited by number in square 
brackets in the text [3, 7.12]. A button which inserts the square brackets and places the cur-
sor between the brackets is available. You just have to type in the reference number.  

Note: In most subject areas the reference list should be alphabetical, even if reference 
numbers are used. If subsequent changes are made, the references must be renumbered ac-
cordingly. Thus, citation by author/s name/s and publication year is preferred. 

9  Sources/Copyright 

If you copy figures, tables, or extended text passages, it is essential to obtain permission 
from the copyright holder (usually the publisher and/or the original author). Permission 
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forms for this purpose are available on our Web site. Please include a copy of the permission 
with your manuscript. The source of any such reproduction must always be acknowledged, 
preferably in the figure legend or the table caption. 

10  Headers and Page Numbers  

Page numbering with Arabic letters begins on the first page of the first chapter of the book 
(or should the book be divided into parts, with the page containing the heading of Part I), 
which is always a right-hand (odd-numbered) page.  

The page number appears in the so-called running headline (header), which also contains 
the title of the current chapter. In monographs, the chapter title appears on the left-hand page 
and the first heading on the right-hand page; in contributed (multi-authored) books, the au-
thor name/s appear/s on the left-hand page and the title of the contribution on the right-hand 
page. The page numbers are placed on the edge. Headers and page numbers appear in a 
smaller font size (see Sect. 3 Fonts) and are separated from the text by a line. 

10.1  Creating the Headers 
Headers are inserted automatically when new text is entered using the document template. If 
you format existing text, click on the first page and then the "Run Head" button.  

Note: For aesthetic reasons, the first page has no header and no page number, but it is in-
cluded in the automatic page numbering. The same holds for every empty page.  

Each chapter should begin on a right-hand page with an odd page number. Therefore, you 
have to insert an empty page after each chapter or manuscript part, that ends on a right-hand 
(odd-numbered) page. To do so, place the cursor at the end of the chapter and from the menu 
bar, select Insert > Break, Section break types "Next page".  

10.2  Preparing the Page Numbers 
It is best not to insert the final page numbers until the entire manuscript has been completed, 
since the text and the page numbering might change when corrections are made. 

You should proceed as follows:  
• Make a note of the number of the last page of Chap. 1.  
• Open Chap. 2 (02.doc).  
• Click the "Page Numbers" button and insert the (odd) page number that Chap. 2 should 

begin with in the dialog box under "Page Number Format, Page numbering, Start at".  
• Make a note of the number of the last page of Chap. 2.  
• Open Chap. 3 (03.doc).  
• etc.  

Note: If the text and page numbers change due to subsequent alterations, you will have to 
correct the page numbers in the chapters that follow.  

10.3  Tips for Creating the Headers and Page Numbers 
• The "Change Margin" function in the document template must be activated before you 

create headers as it defines the right and left pages (see the instructions for downloading 
and using the templates). 

• Before inserting the headers, all headers and footers must be empty. Any existing page 
numbers must be deleted.  

• Ensure that there are no manual section breaks, but only manual page breaks. Manual 
section breaks should only be used for creating empty pages without headers.  
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• Headers should not be longer than one line. 
• If some headers need to be shortened or changed, click directly in the header, delete the 

entire text which has been inserted automatically and enter the correct text manually.  

11  Front Matter  

The parts of a book that precede the first page of the actual text are referred to as the front 
matter and include the following (in this order):  

• Foreword, if any  
• Dedication, if applicable 
• Preface  
• Contents  
• List of contributors (with complete affiliations), if applicable  
• List of abbreviations, if applicable.  

The front matter is numbered in Roman numerals, beginning with p. V. Springer will 
typeset the first four pages of the front matter, including the Title page (p. III) and the copy-
right page (p. IV). 

All main sections (foreword, preface, contents etc.) start on right-hand (odd-numbered) 
pages. If necessary, you will have to insert empty pages (see Sect. 10.1 Inserting the head-
ers). The headings of the main sections are treated as chapter titles (see Sect. 3 Fonts). 

12  Contents 

All the headings up to level three are usually included in the contents. If you have formatted 
the headings with the "Title", "H1", "H2" and "H3" buttons, you can create the contents 
automatically. The contents is part of the front matter (see Sect. 11 Front Matter). 

Creating the Contents: 

• Open a new file and attach the document template. 
• Ensure that the formatting marks such as paragraph marks etc. are shown on screen. If 

not, click the ¶ button to display the formatting marks.  
• Write the word "Contents" (without final format) and place the cursor on the next line. 
• Click the  button. The following box appears: { RD c:\\}  
• Now enter the file name of the first chapter and the path as follows:  

{ RD drive:\\directory\\subdirectory (if applicable)\\file name.file name extension}.  
It might look like this: { RD e:\\manuscript\\Springerbook\\01.doc}. 

Note: Avoid using file or folder names with blanks, e.g. "My documents", since a break in-
duces a stop in reading. Therefore, always write something such as Springer_book or 
Springerbook. 

• Go to the next line, click  again, and enter the path for the next chapter etc.: 
• { RD e:\\manuscript\\Springerbook\\01.doc} 
• { RD e:\\manuscript\\Springerbook\\02.doc} 
• { RD e:\\manuscript\\Springerbook\\03.doc} 
• Click off the formatting marks. 
• Now click the "Table of Contents" button, a contents with headings down to level three 

is automatically created.  
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Note: Do not use this function until all the chapters have been completed and you have che-
cked that each chapter begins with the correct page number. If you make subsequent modifi-
cations to individual chapters causing changes to the text and page numbering, you will need 
to alter the contents accordingly. To do so, select the entire contents and press F9.  

13  Index  

An alphabetically ordered index of significant words is an important aid for the efficient use 
of a scientific book. Only include those words that you, as a reader, would refer to for more 
detailed information.  

13.1  Selecting the Entries  
• In order to indicate which terms should be included, select the relevant word and then 

click the "Keywords" button. 
• The term now appears as a main entry in the "Mark Index Entry" dialog box. Click 

"Mark" to save the term as an index entry.  
• If the term you have selected is a subentry, you will need to copy it into the "Subentry" 

box and type in the main term under "Main Entry". Then click "Mark".  

Note: Never click "Mark All"; otherwise all occurrences of the word selected will be in-
cluded in the index.  

13.2  Creating the Index 
The index appears at the end of the book as a separate chapter with the title "Index" (without 
a chapter number), beginning on a right-hand page. Our document template can be used to 
create the index automatically. The index is created in the same way as the contents.  

• Open a new file and attach the document template. 
• Ensure that the formatting marks such as paragraph marks etc. are shown on screen. If 

not, click on the ¶ button to display the formatting marks.  
• Write the word "Index" (without final format) and place the cursor on the next line. 
• Click the  button. The following box appears: { RD c:\\}  
• Now enter the file name of the first chapter and the path as follows:  

{ RD drive:\\directory\\subdirectory (if applicable)\\file name.file name extension}.  
It might look like this: { RD e:\\manuscript\\Springerbook\\01.doc}. 

• Go to the next line, click  again, and enter the path for the next chapter etc.: 
{ RD e:\\manuscript\\Springerbook\\01.doc} 
{ RD e:\\manuscript\\Springerbook\\02.doc} 
{ RD e:\\manuscript\\Springerbook\\03.doc} 

• Click off the formatting marks. 
• Now click the "Create Index" button, the complete, two-column index is automatically 

created.  

Note: Do not use this function until all the chapters have been completed and you have che-
cked that each chapter begins with the correct page number. If you make subsequent modifi-
cations to individual chapters causing changes to the text and page numbering, you will need 
to alter the index accordingly. To do so, select the entire index and press F9.  
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14  Manuscript Submission to Springer  

After you have embedded all the tables and figures into the chapters, styled the pages, in-
serted the headers and created the table of contents, the index and any further parts of the 
front matter, the file can be converted to PDF. 

14.1  Creating PDF Files 
In order to create PDF files, Acrobat Distiller must be used. Please note: It is not possible to 
use Word files for printing. Furthermore, PDF files produced with the PDF Writer are also 
unsuitable.  

Settings. The job options for Acrobat Distiller with the settings required for producing suit-
able PDF files can be downloaded from our Web site. They are packed in a ZIP archive to-
gether with the template and the instructions for downloading and using the template (see 
Sect. 1.1 Preparation). Download the ZIP file on your PC, unzip it and copy the file 
"SpringerPrint[date].joboptions" to the folder "Settings", which you will find under Program 
> Adobe > Acrobat > Distiller on your PC. Activate the Acrobat Distiller and select under 
"Settings" "SpringerPrint[date]". Alternatively, you can open the first chapter and choose 
Acrobat Distiller as the printer. You can then "print" all your chapters or book parts with 
these settings and thus produce PDF files ready for printing.  

Note: Never change the settings in the job options. Should it be necessary (in exceptional 
cases only), save the changed settings under a new name and inform your Springer contact 
about the changes. This information needs to be forwarded to the printer.  

Distiller. We recommend that you convert your manuscript chapter-wise and name the PDF 
files with the page numbers, Roman and Arabic pages separately, e.g. 001-024.pdf, V-
XII.pdf. If a chapter is very large, you can, of course, divide a chapter. Please ensure that the 
blank pages, e.g. the left pages at the end of a chapter, are included in the PDF (see Sect. 
10.1 Inserting Headers or convert an empty Word page into "empty.pdf" and insert this page 
to the PDF document).  

Please check your final PDF document carefully and ensure that all fonts and special char-
acters appear in the same style as originally intended. If corrections are necessary, make 
these in the Word file and convert again.  

14.2  Submitting the Files and Printout 
Your manuscript files can be submitted on a CD, disk/s, zip disk or alternatively you can use 
Springer's FTP server (if you wish to do so, please contact Springer for further information). 
Do not send completed manuscripts or large files via e-mail. 

In addition to the PDF files, Springer requires a printout for control purposes of the final 
PDF document, not the Word files. When printing the paper version, ensure that the options 
"Shrink oversized pages to paper size" and "Expand small pages to paper size" are deacti-
vated. The PDF files and printout must be identical. If colour figures appear in the manu-
script, a colour printout of each page where these colour figures occur must be provided. If 
this is not possible, please send a list of all figures which should be printed in colour. Finally, 
enclose all copies of the permissions received for reproducing already published material (if 
applicable). 


